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1 PREFACE 

The Bruker Compass LibraryEditor 4.0 application (referred to as ‘LibraryEditor’) is the 
state-of-art Windows XP application for managing mass spectral libraries.  

The LibraryEditor creates and edits the most advanced MS and MSn libraries for use 
with Bruker Compass DataAnalysis. Unlike any other mass spectral library it contains 
mass spectra with full mass precision and essential acquisition parameters. The search 
algorithm from DataAnalysis makes full use of this information. Structural formulas can 
be added to the compounds. The LibraryEditor also supports NIST and NIST user 
libraries created by other programs containing spectra from other vendors. 
 
The LibraryEditor User Manual describes how to work with LibraryEditor 4.0. For refer-
ence on LibraryEditor 4.0 menus and commands, please refer to the LibraryEditor Ref-
erence Manual that is available as PDF document with your installation. 
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2 GETTING STARTED 

2.1 Installing and Uninstalling LibraryEditor 

The LibraryEditor 4.0 application installs automatically when the Bruker Compass 
DataAnalysis 4.0 application is installed on your system. The LibraryEditor application 
is automatically uninstalled when the DataAnalysis application is uninstalled from your 
system. To work with LibraryEditor, a valid 'ESI Compass 1.3' license must be present.  
 

2.2 Compliance Modes and UserManagement 

2.2.1 Running LibraryEditor in Compliance or Non-
Compliance Mode 

LibraryEditor can be operated in ‘Compliance’ or ‘Non-Compliance’ mode. Working in 
Compliance mode can support you to meet FDA 21 CFR Part 11 (FDA’s rule on elec-
tronic signatures and records) requirements. To run LibraryEditor in Compliance mode, 
the Bruker Daltonics Compass Security Pack program providing Bruker Daltonics Use-
rManagement needs to be installed either on this computer or preferably on a central 
server. When the ‘Compass Security Pack’ license is present, LibraryEditor is running 
in Compliance mode automatically. Otherwise, LibraryEditor is running in Non-Compli-
ance mode. 

Note: Compliance mode in the context of Compass Security Pack exclusively means 
the availability of Compass Security Pack tools and functionalities, which can be 
used to support the user to meet 21 CFR Part 11 requirements. Neither Com-
pliance mode nor Compass Security Pack can assure full compliance with 21 
CFR Part 11 requirements. 

Compliance mode 
The Compliance mode offers the following features for LibraryEditor: 
• Only operators created by the customer’s UserManagement administrator can log 

into LibraryEditor after identification by operator ID and password. 
• The UserManagement administrator can administer access to LibraryEditor by 

assigning individual rights to the operators he creates. These rights concern the 
actions the operator is allowed to perform in LibraryEditor. 
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• All Bruker Daltonics applications that are installed on the operator’s computer can be 
locked and unlocked by the operator. 

Note: The features above apply to any application supported by the Bruker Daltonics 
UserManagement. 

Non-Compliance mode 
When LibraryEditor is running in Non-Compliance mode: 
• Anybody can log into LibraryEditor; no identification by operator ID and password is 

needed. 
• Operators having different LibraryEditor rights do not exist. 
• LibraryEditor and other Bruker Daltonics applications cannot be locked. 
 

2.2.2 Bruker Daltonics UserManagement 

When LibraryEditor is running in Compliance mode LibraryEditor uses the Bruker 
Daltonics UserManagement application.  

UserManagement enables you to administer access to Bruker Daltonics applications 
and manage individual action rights based on operator ID and password. Creating 
operators and assigning rights to them is performed using the Bruker Daltonics User-
Management Administration Tool application. Only the customer’s UserManagement 
default administrator and perhaps further UserManagement administrators (if having 
the ‘UserManagement Administration Tool: Administrate Operators’ right) have the right 
to create operators which should use LibraryEditor and assign individual rights to them 
concerning the actions these operators are allowed to perform in LibraryEditor.  
Before anybody apart from the UserManagement default administrator can log into 
LibraryEditor when in Compliance mode, the UserManagement administrator has to 
create (an) desired operator(s) specified by operator ID and password. To become 
effective an operator must be assigned to an operator group having specific rights 
included. The UserManagement administrator can use the auto-generated operator 
groups or he can define new groups to customize right assignments according to his 
own requirements. All members within a group will have the same rights. In addition, 
the UserManagement administrator can modify the default password policy and timeout 
settings as desired. 
Note: For detailed information on how to create operators and assign rights, please 

refer to the UserManagement help tools. 
 
UserManagement is client-server based. On the server PC the database defining 
operators and their rights is installed, on the client PC the Bruker Daltonics applications 
are installed. 
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2.2.2.1 LibraryEditor Operating Rights in UserManagement 

In UserManagement specific rights for performing actions in LibraryEditor exist that can 
be assigned to an operator group and, therefore, to an operator. If an operator wants to 
perform an action without having the respective right corresponding information will 
appear. 

The rights existing in LibraryEditor are listed below (in alphabetical order). In most 
cases, several actions are associated with a single right, which an operator having this 
right is allowed to perform in LibraryEditor. The Open library right is the lowest right 
somebody must have to view data with LibraryEditor.  
Right: Allows performing actions concerning the following 

subjects:  
• Change configuration Configuring LibraryEditor and customizing user interface.  

• Create library, add 
spectra 

Creating new libraries, adding spectra, exporting libraries. 

• Delete spectra Deleting spectra. 

• Modify spectra Modifying spectra e.g., importing libraries and compound 
information, checking and rebuilding libraries, importing and 
deleting chemical structures, changing spectra. 

• Open library Opening, refreshing and closing libraries, accessing NIST 
library, importing spectra, finding compounds. 

 

2.2.2.2 Auto-Generated Operator Groups and Their Right Assignments in 
LibraryEditor 

In UserManagement various so-called ‘auto-generated’ operator groups are predefined 
with each of them having specific rights for performing actions in LibraryEditor included. 
The UserManagement administrator can assign a new operator to one of these auto-
generated groups if he does not want to define own groups but he cannot change the 
right assignment of the predefined groups. 

The following operator groups are predefined in UserManagement (in alphabetical 
order): 
• Administrators (auto-generated) 
• Operators (auto-generated) 
• Project Managers (auto-generated) 
• Scientists (auto-generated) 
• Service (auto-generated) 
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Which LibraryEditor rights are assigned to the auto-generated operator groups is 
shown below (the figures show the respective sections in the UserManagement Admi-
nistration Tool). No difference exists between an operator of the ‘Administrators (auto-
generated)’ and the ‘Project Managers (auto-generated)’ group; both have all rights 
that are available for this application. An operator of the ‘Scientists (auto-generated)’ 
group lacks the Delete spectra and Modify spectra rights. An operator of the 
‘Operators (auto-generated)’ group also lacks the Create library, add spectra right. 
The ‘Service (auto-generated)’ group is needed for service purposes of the manu-
facturer. 
‘Administrator’ ‘Project Manager’ 

    
‘Scientist’ ‘Operator’ 

    
Figure 2-1 LibraryEditor rights assignments of the predefined operator groups 
 

2.3 Starting LibraryEditor 

You can start LibraryEditor from the Windows Start menu. During installation of the 
Bruker Daltonics applications package, a Bruker Daltonics folder was created auto-
matically in the Start menu’s Programs folder. This folder contains the respective 
applications. Alternatively, you can start LibraryEditor via Windows Explorer by double-
clicking an existing library file (*.mlb) that automatically starts LibraryEditor and opens 
the respective library. You can also start it from DataAnalysis. 
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On starting LibraryEditor, a dialog appears that requests you to log unless you are 
currently logged in another Bruker Daltonics application (for Compliance as well as 
Non-Compliance mode) or the corresponding option for skipping this dialog is set (for 
Non-Compliance mode only). 
After log in is performed, LibraryEditor starts with the user interface displayed accord-
ing to the settings stored for the user currently logged into Windows. The currently 
logged in operator is displayed in the status bar of the LibraryEditor window. 
 
To start LibraryEditor via the Windows Start menu: 

1. Click . 
2. Click Programs. 
3. Click Bruker Daltonics. 
4. Click LibraryEditor. This starts LibraryEditor and opens the LibraryEditor dialog. 

  
5. Log in if requested. 

To start LibraryEditor via Windows Explorer with opening the selected library: 
1. Start Windows Explorer. 
2. Navigate to the library file you want to open. 
3. Double-click the library file. This starts LibraryEditor and opens the LibraryEditor 

dialog. 
4. Log in if requested. 

To start LibraryEditor from DataAnalysis: 
1. Start DataAnalysis. 
2. From the Tools menu, select LibraryEditor. This starts LibraryEditor and opens 

the LibraryEditor dialog. 
3. Log in if requested. 
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2.4 Logging an Operator into LibraryEditor 

When LibraryEditor is running in Compliance mode, only operators created by the 
UserManagement administrator can log into LibraryEditor after being identified by their 
operator ID and password. Multiple successive wrong logons will cause locking of the 
operator. The UserManagement administrator defines the maximum number of false 
attempts allowed. When LibraryEditor is running in Non-Compliance mode, any 
operator can log in after entering an operator ID. Identification by password is not 
required.  
Note: Only one operator can be logged into Bruker Daltonics applications on a speci-

fic computer at a time. 
Log in must be performed after starting LibraryEditor unless you are currently logged in 
another Bruker Daltonics application (for both Non-Compliance and Compliance 
mode). When LibraryEditor is running in Non-Compliance mode an option for automatic 
log in of a specified operator can be set.  
In Compliance mode, if LibraryEditor is the first Bruker Daltonics application into which 
you want to log after the UserManagement administrator has defined you as a new 
operator, you will be required by the program to change your password. 
When LibraryEditor is running, the currently logged in operator is identified in the status 
bar. 

To log into LibraryEditor: 
1. Start LibraryEditor or when in a running session select Operator from the Help 

menu. This opens the LibraryEditor dialog that corresponds to the mode in which 
LibraryEditor is currently running. 

2. In Operator, enter your operator ID. The operator ID is not case-sensitive. 
3. In Non-Compliance mode, check Always log in using this operator if you want 

the specified Operator to be logged in the next time automatically without showing 
the log on dialog again. 

4. In Compliance mode, enter your password in Password.  
Note: Passwords are case-sensitive. Be careful, too many successive wrong 

inputs will cause locking. 
5. Click Log On. In Compliance mode, log in will be successful only if operator ID and 

password match. 
6. If you are required to change your password, change it in the Change Password 

dialog and then repeat steps 4 and 5. 
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2.5 Changing the Operator's Password 

When LibraryEditor is running in Compliance mode, the operator who wants to log in 
has to identify by password.  

The program will require you to change your password when you log into a Bruker 
Daltonics application supporting UserManagement the first time after the UserManage-
ment administrator has defined you as new operator. You must also change your 
password after the administrator has changed your password or has forced a password 
change on you. Apart from this, you can change your password whenever you want 
either when logging into LibraryEditor or during a running LibraryEditor session. The 
new password must comply with the current password policy settings defined by the 
UserManagement administrator. 

To change an operator’s password: 
1. Start LibraryEditor or when in a running session, select Operator from the Help 

menu. This opens the LibraryEditor dialog. 
2. In Operator, enter your name. 

Note: The operator ID does not distinguish between capital and small letters. 
3. Click Change Password. This opens the Change Password dialog.  
4. In Operator, the ID of the operator whose password can be changed is identified. 

If the password for another operator should be changed, click Cancel to return to 
the LibraryEditor dialog and repeat steps 2 and 3. 

5. In Old password, enter your current password. The password will not be dis-
played as you type it. 
Note: Passwords are case-sensitive. 

6. In New password, enter the new password. 
Note: Make sure, that the new password complies with the current password poli-

cy settings. 
7. In Confirm new password, enter your new password again. 
8. Close the message confirming a successful password change. If an error message 

appears, repeat the corresponding steps. 
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2.6 Locking and Unlocking an Operator 

The UserManagement can lock an operator after entering too many wrong passwords 
in succession. The UserManagement administrator defines how many wrong inputs are 
allowed. Furthermore, an operator can be locked by direct UserManagement admini-
strator action. The operator will get information about being locked after locking has 
occurred. 

A locked operator cannot log into any Bruker Daltonics application supporting User-
Management. Only the UserManagement administrator can unlock a locked operator. 
 

2.7 Locking and Unlocking LibraryEditor and All 
Other Bruker Daltonics Applications 

When LibraryEditor is running in Compliance mode, you can lock LibraryEditor and all 
other Bruker Daltonics applications currently installed on your system. Only the previ-
ous operator or someone with the special right to unlock applications can unlock a 
locked application.  

Note: The Lock All Applications command is only available when LibraryEditor is 
running in Compliance mode. 

Note: Automatic locking of all UserManagement using Bruker Daltonics applications 
will occur if one of these applications has not been used for a certain period 
defined by the UserManagement administrator. 

To lock all Bruker Daltonics applications: 

1. Click . Or press the Ctrl+Alt+K keys. Or from the Help menu, select Lock All 
Applications. This opens the LibraryEditor dialog that informs you that Library-
Editor is currently locked and how it can be unlocked. 

 
To unlock all Bruker Daltonics applications: 
1. In the LibraryEditor dialog, enter in Operator your operator ID. The dialog dis-

plays the name of the previous operator who has locked Bruker Daltonics appli-
cations.The respective ID will automatically be entered if the UserManagement 
administrator has set the corresponding option. Anyone other than the previous 
operator who wants to unlock the applications must enter the operator ID.  
Note: The operator must have the right to unlock applications. 

2. If you want to change your password before logging in, click Change Password 
and change it as desired. 
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3. In Password, enter the password for the operator named in Operator. 
Note: Passwords are case-sensitive. Successive wrong password inputs will 

cause locking of the operator. 
4. Click Log On. If operator ID and password match and if the respective operator is 

allowed to unlock applications, LibraryEditor is unlocked and the operator is 
logged in. 

 

2.8 Closing LibraryEditor 

You can close LibraryEditor when you have finished your current session. Upon 
closing, the current user interface settings are automatically stored for the user current-
ly logged into Windows. 
 
To close LibraryEditor: 

1. Click the application's Close  or from the File menu, select Exit. 
2. Answer the confirmation request for saving the unsaved processing state of the 

open library/libraries if a message appears. 
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3 LIBRARYEDITOR USER INTERFACE 

The LibraryEditor user interface consists of the title bar, menu bar, toolbar, status bar 
and one to several library windows. LibraryEditor supports multi-library operation, 
which means that you can have several libraries opened at a time with one being 
active. Libraries, which are simultaneously open, display in multiple windows that you 
can manipulate with respect to their size, position and arrangement. You can 
customize the user interface according to your requirements. 
 

 

Figure 3-1 LibraryEditor user interface showing data for a compound in the library 
indicated in the title bar (library window displays in maximized mode) 

The library window displays the data, which is currently available for the selected com-
pound of the respective open library whose name is shown in the window's title bar. If 
this library is write-protected, a [read-only] appendix indicates this. The Compound 
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Data field shows compound-specific information such as the running index number, 
name, or chemical formula and allows opening the Synonym list. The Mass Spectra 
Data field shows the mass spectral information that is currently available for the 
selected compound. This includes the mass spectra contained for this compound in the 
library and the corresponding acquisition parameters, analysis info, Mass List and line 
spectrum. The Structure window displays the chemical structure of the selected com-
pound if available. 
 

3.1 Compound Data 

3.1.1 Compound Data Field 

The Compound data field displays compound-related data for the selected compound 
of the active library. 
 

  
Figure 3-2 Compound data 

Compound 
Compound ID of the compound. The compound ID is automatically given by the system 
when the compound is added to the library. This box is always read-only.  

Nominal mass 
Nominal mass of the compound. The nominal mass has to be entered by the user. 
Entering a value is only possible if no chemical formula is entered in Chem(ical) for-
mula since entering a chemical formula will result in the Nominal mass box becoming 
read-only with the current nominal mass value being kept. No nominal mass calculation 
will occur from the chemical formula entered. 

Monoiso(topic) mass 
Monoisotopic mass of the compound. This is calculated by the system from the chemi-
cal formula currently entered in Chem(ical) formula. If no chemical formula is entered, 
no monoisotopic mass is given. This box is always read-only.  

Average mass 
Average mass of the compound. This is calculated by the system from the chemical 
formula currently entered in Chem(ical) formula. If no chemical formula is entered, no 
average mass is given. This box is always read-only.  
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Name 
Name currently assigned to the compound. On adding a new compound by importing a 
mass spectrum from the file system into LibraryEditor, this box will show a name made 
up from the analysis name and the retention time. If a mass spectrum is exported from 
the Bruker Compass DataAnalysis application directly into LibraryEditor, the compound 
name specified in the corresponding DataAnalysis dialog will appear. The compound 
name can be changed. 

CAS number 
CAS number of the compound provided such a number exists for the respective 
compound and has already been entered. 

NIST number 
NIST number of the compound. 
Note: This entry box is only present if the original NIST library is loaded. 

UN number 
UN number of the compound. 
Note: This entry box is only present if the original NIST library is loaded. 

Chem(ical) formula 
Chemical formula of the compound if already entered. From this formula the system 
calculates the corresponding Monoiso(topic) mass and Average mass. Entering a 
chemical formula will result in the Nominal mass box becoming read-only.  

Comment 
Comment currently entered for the compound. 

Synonyms 
Opens the Edit Synonyms dialog, which lists the synonyms currently available for the 
compound and allows you to edit the synonym list. The number of synonyms currently 
contained in the synonym list is indicated on this button (e.g. ‘(2)’). 
 

3.1.2 Synonym List  (Edit Synonyms Dialog) 

The Synonym list contains all synonyms already entered for the selected compound of 
the active library in alphabetical order. You can edit this synonym list.  

The Synonym list is opened by clicking the Synonyms button in the Compound Data 
field, which indicates the number of synonyms currently edited. It is displayed in the 
Edit Synonyms dialog. You can edit the Synonym list of the selected compound e.g., 
by adding new synonyms or changing or deleting already existing synonyms. 
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Figure 3-3 Edit Synonyms dialog listing the synonyms already entered for the 

selected compound 

Synonyms 
Displays the synonym that is selected in the synonym list below. 
To add a new synonym enter its name and click Add. To change the selected syno-
nym, change it as desired and click Change. 

(Synonym list) 
Lists all synonyms currently available for the selected compound. On selecting a syno-
nym from this list, its name is shown in Synonyms. 

Add 
Adds the synonym entered in Synonyms to the synonym list. 

Change 
Changes the selected synonym according to the changes made in Synonyms. 

Remove 
Removes the selected synonym from the synonym list. 
 

3.1.3 Structure Window 

The Structure window displays the chemical structure for the selected compound if 
available in the active library.  

If the library does not contain this structure data, you can import the corresponding 
*.mol file to display it. Deleting the structure will result in the structure is removed from 
this window. 
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Figure 3-4 Structure window displaying the chemical structure of the selected com-

pound 

 

3.2 Mass Spectra Data 

3.2.1 Mass Spectra Data Field 

The Mass Spectra data field displays the mass spectral data currently contained for the 
selected compound in the active library. This field includes the Mass Spectra list, 
Acquisition Parameter tab, Spectrum Info tab, Mass List tab and Mass Spectrum 
window. The Structure window is placed in this area, too. 
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Figure 3-5 Mass Spectra data field displaying the data available for the selected 

spectrum 
 

3.2.2 Mass Spectra List 

The Mass Spectra list itemizes all mass spectra currently contained for the selected 
compound in the active library. The mass spectra are listed in sequence of their adding 
to the library. Each mass spectrum is represented by a short description indicating the 
instrument type, ionization method, ion polarity and MS/MS stage that was used in 
acquiring the mass spectrum.  

 
Figure 3-6 Mass Spectra list showing the spectra currently available for the selected 

compound in the active library 
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When selecting a mass spectrum from this list, its Spectrum ID is shown above the list 
and its line spectrum is displayed in the Mass spectrum window. Corresponding infor-
mation is displayed in the Acquisition Parameters, Spectrum Info and Mass List 
tabs. 
 

3.2.3 Mass Spectrum Window 

The Mass Spectrum window displays the line spectrum that corresponds to the mass 
spectrum selected in the Mass Spectrum list. It shows the masses present and their 
relative abundances with regard to the base peak (100% mass). A common mass axis 
range is used for all mass spectra of a compound. 

The corresponding m/z and abundance values can be read from the Mass List tab. 
The Mass List can be edited which will result in the displayed line spectrum automati-
cally being changed accordingly. 
 

 
Figure 3-7 Display of the line spectrum that corresponds to the selected mass spec-

trum 
 

3.2.4 Acquisition Parameters Tab 

The Acquisition Parameters tab displays information about the acquisition parame-
ters that were used in acquiring the mass spectrum selected in the Mass Spectra list.  

Some of this data is automatically entered when a mass spectrum is added to the libra-
ry (e.g. Instrument type, Ionization method, Ion polarity, MS/MS stage, Precursor 
ions [m/z] (for MS>1), Base peak [m/z], Peak width [m/z], if being Charge decon-
voluted) if LibraryEditor can read the corresponding information from the respective 
data file. You can enter additional acquisition information on the respective mass spec-
trum in the corresponding parameter boxes. 
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Figure 3-8 Acquisition Parameter tab displaying the acquisition parameters used in 

acquiring the selected mass spectrum 
 

3.2.5 Spectrum Info Tab 

The Spectrum Info tab displays general information about the mass spectrum selected 
in the Mass Spectra list.  
 

 

Figure 3-9 Spectrum Info tab displaying information about the selected mass spec-
trum  

The data shown in Analysis name, Instrument name, Date, Operator name and 
Change date is entered by the system and cannot be edited by the operator.  

Analysis name 
Name and path of the analysis the mass spectrum originates from. 
Note: Name and full path of an analysis are only shown for a new mass spectrum 

added to a new library (library version number 2.2). 
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Instrument name 
Name of the instrument on which the analysis the mass spectrum originates from was 
acquired. 

Date 
Date and time the analysis the mass spectrum originates from was acquired. 

Operator name 
Name of the operator who has last processed the mass spectrum e.g., by adding it to 
the active library or changing its Mass List or spectrum info. 
Note: Operator is only filled in new libraries (library version number 2.2) when a new 

spectrum is added or an existing spectrum is changed.  

Change date 
Date and time the mass spectrum has been processed last. 
Note: Change date is only filled in new libraries (library version number 2.2) when a 

new spectrum is added or an existing spectrum is changed.  
 
Optionally, you can enter following information about: 

Column 
Column used for acquiring the analysis. 

Retention time [min] 
Retention time of the mass spectrum. This data is entered by the system but can be 
edited. 

Contributor 
Name of the contributor who has acquired the mass spectrum. 

Comment 
Comment e.g. on the mass spectrum or analysis. 
 

3.2.6 Mass List Tab 

The Mass List tab displays the Mass List of the mass spectrum selected in the Mass 
Spectra list. The corresponding line spectrum is displayed in the Mass Spectrum win-
dow. 

The Mass List tab lists all masses currently present in the line spectrum and their corre-
sponding abundances. You can edit the Mass List e.g., by adding new masses or 
changing or removing existing masses. Each change results in the line spectrum dis-
played is immediately altered accordingly. 
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Figure 3-10 Mass List tab displaying the Mass List of the selected mass spectrum 

Masses [m/z] 
Current masses of the selected mass spectrum. 

Abundances  
Corresponding abundances of the masses listed.  

Mass 
Mass value of the mass currently selected in Masses [m/z].  
Abundance 
Abundance of the mass currently selected in Masses [m/z] with the abundance of the 
base peak being set to '999'.  

Mass range 
Acquired mass range of the mass spectrum. 
Note: Mass range is only filled for a new mass spectrum added to a new library 

(library version number 2.2).  

No. of masses 
Number of masses contained in the mass spectrum. 

New 
Adds the mass currently specified in Mass and Abundance as a new mass. 

Remove 
Removes the mass currently selected in Masses [m/z]. 
Normalize 
Normalizes the line spectrum displayed in the Mass Spectrum window e.g. if the 100% 
mass has been removed. 
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3.3 Customizing the User Interface 

You can customize the user interface with respect to the current display state of the 
toolbar and status bar, which both are shown by default. Since LibraryEditor supports 
multi-library operation using multiple windows, you can toggle between different display 
modes showing only either the window of the active library or the windows of all 
libraries currently open simultaneously. In the latter case, you can resize and move the 
individual library windows or minimize single windows to icons.  
 

3.3.1 Showing and Hiding the Toolbar 

The toolbar is positioned below the menu bar by default. You can hide the toolbar and 
show it again.  

To show or hide the toolbar: 
1. From the View menu, select Toolbar. 
 

3.3.2 Showing and Hiding the Status Bar 

The status bar is positioned at the bottom of the LibraryEditor window by default. You 
can hide the status bar and show it again.  

To show or hide the status bar: 
1. From the View menu, select Status Bar. 
 

3.3.3 Manipulating Library Windows 

LibraryEditor supports multi-library operation, meaning that you can have several 
libraries open at a time displayed in multiple windows.  

On opening a library, by default, it displays in a window being maximized with the 
library name shown in brackets in the LibraryEditor window's title bar and its window 
size depends on the current size of the LibraryEditor window.  
If you have more than one library open at a time you can switch from the maximized 
mode showing only the active library to display modes showing also the windows of the 
other open libraries. In the multiple windows mode each library is displayed in a 
separate window having its own title bar indicating the name of the respective library. 
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The active library is always shown on top with its title bar being highlighted. You can 
arrange multiple windows in different ways as well as resize and move them within the 
current borders of the LibraryEditor window. In addition, you can minimize such a 
window if you wish to keep the respective library open but temporarily exclude its 
window from being displayed among the other library windows. 
 

3.3.3.1 Moving a Library Window 

You can move a library window to another position on the user interface. This may 
result in only part of the library window being shown.  

To move a library window to another position: 
1. Position the mouse pointer on the title bar of the library window you want to move. 
2. Drag the window, with the left mouse button depressed, to the desired new posi-

tion and release the mouse button.  
 

3.3.3.2 Resizing a Library Window 

You can change the size of the active library window by dragging its borders. The pro-
gram sets a minimum permissible size whereas the maximum possible size depends 
on the current size of the LibraryEditor window. 
In addition, you can minimize a library window or maximize it by clicking its  but 
maximizing will result in changing the display mode to show only the active library, but 
not several libraries simultaneously.  

To resize the width of a library window: 
1. Click the library window you want to resize. 
2. Position the mouse pointer on the left or right window border so it changes to . 
3. Drag the border, with the left mouse button depressed, to the left or right until the 

desired or the minimum/maximum window size is reached. Then release the 
mouse button. 

To resize the height of a library window: 
1. Click the library window you want to resize. 
2. Position the mouse pointer on the upper or lower window border so that is changes 

to . 
3. Drag the border with the left mouse button depressed up or down until the desired 

or minimum/maximum window size is reached. Then release the mouse button. 
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3.3.3.3 Arranging Library Windows 

The library windows will be arranged and sized by default. In the case of the cascade 
view, each of the respective windows has the same default size but is shifted by title 
bar height and an angle of 45°. In the tile view, the windows are sized according to the 
current size of the LibraryEditor window, provided this does not remain under the mini-
mum allowed size set for a library window.  
You can switch the display to show the library windows of all open, currently not mini-
mized libraries in cascade or tile view. If desired, you can move the windows to new 
positions and/or resize them. When switching to another view, changed window sizes 
will be reset to the default values. 

To arrange multiple windows in cascade view: 
1. From the Window menu, select Cascade. 

To arrange multiple windows in tile view: 
1. From the Window menu, select Tile.  
 

3.3.3.4 Minimizing Library Windows and Arranging Icons 

You can minimize a library window to an icon and arrange the icons present in a 
straight line at the bottom of the LibraryEditor user interface. Minimizing a library 
window keeps the corresponding library open but excludes the respective window from 
being displayed among the other multiple windows.  

To minimize a library window: 

1. Click the library window's . This minimizes the active library window to an icon 

e.g. . 

To arrange icons of minimized library windows: 
1. From the Window menu, select Arrange Icons. 
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4 CREATING AND MANAGING LIBRARIES 

To perform a library search on acquired, unknown mass spectra LibraryEditor allows 
you to build appropriate mass spectral libraries containing MS and MS/MS spectra of 
the compounds you are interested in. How a new library is created and how an existing 
library can be managed is described in this section. This includes creating, opening, 
activating, saving, refreshing, exporting and checking libraries as well as accessing 
NIST user libraries. Chapter 5 describes how a library can be build, i.e. is filled with 
data.  
 

4.1 Creating a New Library 

You can create a new library having the Library Files format (*.mlb). This is required for 
building a new library e.g., by importing and adding mass spectra or importing other 
libraries.  

Each library must be placed in a separate folder. This is necessary since the various 
data files which are generated during library set up will have identical names for all 
libraries created, except for the library file (*.mlb) whose name you select. Therefore, 
when creating a new library, first set up a new folder with the name of the library you 
want to create and then create the library and save it in the respective folder. 
On saving a new library, the specified *mlb file as well as the specific corresponding 
data files are set up and saved to the selected folder. The library is automatically 
opened. 

To create a new library: 

1. Click  or select New from the File menu. 
3. Navigate to the folder the new library should be saved to. 

2. Click  to create a subfolder for the library you want to set up. 
3. Enter the folder name in the appearing frame. 
4. Double-click the new subfolder to open it. 
5. In File name, enter the name of the new library. 
6. Click Save. 
7. Build the newly created library. 
 



Creating and Managing Libraries Bruker Daltonik GmbH 

4-2 LibraryEditor User Manual, Version 4.0 

4.2 Opening a Library 

LibraryEditor uses Windows conventions for opening library files. You can open a 
library either from LibraryEditor or from Windows Explorer. LibraryEditor supports the 
drag-and-drop functionality, i.e. you can open a library by dragging its file name (*.mlb) 
from Windows Explorer into the LibraryEditor window. On opening a library, the library 
displays in a new library window with the first compound shown that is contained in 
respective library. 

To open a library from LibraryEditor: 
1. Start LibraryEditor. 

2. Click  or select Open from the File menu. 
3. In Look in and the folder list, navigate to that folder that contains the library file 

(*.mlb) you want to open. 
4. Double-click the desired library file. Or click the library file and click Open. 
Tip: You can quickly open a library you have recently processed by clicking the 

respective recent file list name at the bottom of the File menu. 

To open a library from Windows Explorer using drag and drop: 
1. Start LibraryEditor. 
2. Start Windows Explorer. 
3. Navigate to the folder which contains the library file (*.mlb) you want to open. 
4. Click the desired library file and drag it with left mouse button depressed in the 

LibraryEditor window. Then release the mouse button. 

To open a library from Windows Explorer by double-clicking it: 
1. Start Windows Explorer. 
2. Navigate to the folder, which contains the desired library file (*.mlb). 
3. Double-click the library file. This starts LibraryEditor and opens the respective 

library. 
 

4.3 Activating a Library 

If more than one library is opened at a time, you have to activate the respective library 
you want to view and/or process. All currently open libraries are listed in the open 
library list at the bottom of the Window menu. The active library is indicated by a check 
mark in front of its name. 
If the maximized window mode is active, i.e. only the active library is shown with its 
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corresponding library window being maximized, you can activate another library only by 
selecting it from the open library list. If multiple windows are simultaneously displayed 
and cover each other only partially, e.g. when the cascade view or tile view is active, 
you can activate the desired library by just clicking the respective library window. This 
puts the respective library window on top. 

To activate an open library: 
1 From the Window menu, select the desired library from the open library list. Or 

click the respective library window if visible. 
 

4.4 Refreshing a Library 

You can refresh the active library. This is required if at least two computers within a 
network access the same library. For example, on computers A and B the library X is 
open; computer A is viewing entries and computer B is writing into the library. For 
computer B, the library is refreshed automatically whereas Computer A will see the 
changes made by computer B not automatically but after performing a refresh on the 
library. Computer A will also see these changes after deactivating (= activating another 
application) and re-activating LibraryEditor since this will cause an automatic refresh. 

To refresh a library: 
1. Activate the library you want to refresh. 
2. From the File menu, select Refresh. 
 

4.5 Saving Changes Made to a Library 

The program will automatically save changes you made to the active library by adding 
or deleting mass spectra. In contrast, if you have altered the currently selected com-
pound concerning its current compound or mass spectrum data e.g., by editing a mass 
spectrum’s Mass List or the compound's synonym list, you can decide whether these 
changes should be saved. Use this procedure to save the changes you have made to 
the compound data of the selected compound or to one of its mass spectra.  
If you made changes to the current compound or its selected mass spectrum but have 
not saved them yet, the program will ask you about saving these changes each time 
you try to select another mass spectrum. Affirm this confirmation request if you want 
the changes to be saved.  

To save changes made to a compound or its mass spectrum: 

1. Click  or from the Spectrum menu, select Save. 
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4.6 Showing Library Properties 

You can show the properties of the active library concerning the library name and path, 
status, number of compounds and spectra contained, and version number. 

To show properties of a library: 
1. Activate the library whose properties you want to show. 
2. From the File menu, select Properties. 
 

4.7 Exporting a Library 

 You can export the active library to Library File format (*.mlb) or to ASCII Library File 
format (*.library) which is fully NIST compatible. The *.library format allows loading the 
exported library into the NIST. It is almost identical with the ASCII MS Spectrum File 
format (*.spectrum) with the one difference that the *.library format can hold any 
number of mass spectra but the *.spectrum format only a single one. 

To export a library: 
1. Activate the library you want to export. 
2. From the File menu, select Export Library. 
3. In Save in and the folder list, navigate to the folder to which the exported *.library 

file should be saved. 
4. In Name, enter the name for the *.library file to be exported or select a name from 

the folder list. 
5. In Save as type, select the format the library should be converted to. 
6. If Library File (*.mlb) is selected, check Exclude compound information if only 

compound names but no additional compound information should be included in 
the exported library. 

7. Click Save. 
8. If you have chosen an existing file name, affirm the appearing confirmation request 

on overwriting the existing file. 

4.8 Accessing a NIST User Library and Locating the 
NIST Main Library 

LibraryEditor allows you to access a NIST user library (named User.dbu) not yet having 
the Library Files format (*.mlb) required by LibraryEditor. Access creates the corre-
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sponding *.mlb file ('library name'.mlb) that can be opened and processed in Library-
Editor. Information about mass spectrum acquisition (e.g. polarity, MS/MS stage, pre-
cursor ion, production) that is stored in the respective NIST user library is automatically 
entered in Acquisition Parameter of the corresponding mass spectrum if LibraryEditor 
can read this information from the user library. 

Additionally, you can specify the location of the NIST main library as an option, which 
allows chemical structures from the NIST user libraries to be resolved from the NIST 
main library. 

To access a NIST user library w/o specifying location of the NIST main library: 
1. From the File menu, select Access NIST Library. This opens the Access NIST 

User Library dialog. 
2. In Look in and the folder list navigate to the respective NIST user library folder 

and open it. 
3. Double-click the User.dbu file or select it and click Open. 
4. If the location of the NIST main library has not been specified yet, the NIST Libra-

ry dialog appears which allows you to enter the location as an option. If you want 
to, enter the respective path or click  to select it in the appearing NIST Main 
Library dialog. Then click OK. Otherwise, click Cancel. 

5. A message informs you about successful creation of access file(s) and asks if you 
want to open the library now. If you want to, click OK. 

 

4.9 Checking and Rebuilding a Library with Con-
verting to the New Library Format 

You can check and rebuild a selected library having the Library Files format (*.mlb). 
This is necessitated if error messages have appeared when performing library 
searches in DataAnalysis and/or when browsing the respective library in LibraryEditor.  

In addition, you can use library check and rebuild to convert libraries created with Libra-
ryEditor 3.1 or below to the new library format supported since LibraryEditor 3.2, which 
provides additional properties for mass spectra. It is recommended to convert existing 
libraries set up with a previous LibraryEditor version (library version number 2.0 or 2.1) 
to the new library format to make use of the new properties additionally available for 
mass spectra. The version number of a library can be examined from the Properties 
command from the File menu. 
Note: A prerequisite is that all installations containing a ‘LibraryEditor’ and all compu-

ters containing mass-spectral libraries are updated at least to ‘esquire 5.2’, 
‘DataAnalysis 3.2’, or ‘LibraryServer 1.2’, including any higher version of those. 
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You can also use library check and rebuild to reduce mass spectra consisting of a huge 
number of masses to the most abundant ones. Rebuilding then creates a library con-
taining only spectra with at most the specified number of masses. The number of 
masses a selected spectrum consists of you can examine from the Mass List tab. 

Checking and rebuilding a library creates a new, rebuilt library having the version num-
ber 2.2 while the original library is still preserved. Depending on whether the original 
library is writable or read-only, library check and rebuild proceeds as follows: For 
writable libraries, the rebuilt library replaces the original one after this was saved to a 
new backup-subfolder named either ‘BAK’ or ‘BAK_n’ (with n ≥ 2). For read-only librar-
ies, the rebuilt library is saved to a new subfolder named ‘YYMMDDhhmmss’ (Y: year, 
M: month, D: day, h: hour, m: minute, s: second) with the original library remaining 
unchanged. 
If the library you want to check and rebuild is open when check is prompted, the library 
is automatically closed and opened again after rebuild is finished, i.e. after you have 
clicked Close in the Check Library Progress dialog.  
To check and rebuild a library: 
1. From the File menu, select Check Library. This opens the Check Library dilog 

box. 
2. In Look in and the folder list, navigate to the folder that contains the library file 

(*.mlb) you want to check. 
3. Check Limit mass spectra to N most abundant masses if you want to reduce 

spectra containing a huge number of masses to a specified number of most abun-
dant masses and enter the desired number in the box to the right.  

4. Click Open. While library check and rebuild is running, the Check Library Pro-
gress dialog informs you about the progress of rebuild. 

5. After rebuild is finished, click Close. 
 

4.10 Closing a Library 

You can close the active library if you do not want to have it open any longer. If 
changes made to the last selected compound have not been saved yet, a confirmation 
request will appear for saving theses changes. 

To close a library: 
1. Activate the library you want to close. 
2. From the File menu, select Close.  
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5 BUILDING LIBRARIES 

LibraryEditor allows you to build specific MS and MS/MS libraries which you can use 
for library searching and mass spectrum identification to be performed in DataAnalysis. 
Such libraries can hold one to several MS and MS/MS spectra for each compound 
present. Filling a library with data includes adding mass spectra by importing single 
spectra or a complete library and then editing the compound and/or mass spectrum 
data  

Building a library includes the following major steps: 
• Creating a new library (Section 4.1) 
• Adding mass spectra to this library 
• Processing the compounds and their mass spectra present in the library 
 

5.1 Adding Mass Spectra to a Library 

For building a new library, you have to add MS and MS/MS spectra to this library. This 
can be done by first importing a mass spectrum from the file system and then specify-
ing whether the respective spectrum should be added as a new compound entry to the 
active library or as a new (additional) spectrum to a compound already existing in the 
respective library. Alternatively, you can add a new mass spectrum or compound 
directly from DataAnalysis to an existing library. Or you can import another library into 
the active library with all compounds not yet present in the target library being added 
automatically as new compound entries and all mass spectra belonging to already 
existing compounds being added as additional spectra to the respective compounds. 

After adding, you can process a new compound or mass spectrum e.g. by editing the 
corresponding data. 
 

5.1.1 Importing a Mass Spectrum 

You can import a mass spectrum of the ASCII MS Spectrum Files format (*.spectrum) 
or NIST ASCII MS Spectrum Files format (*.msp) from the file system. This allows 
adding the respective mass spectrum to the active library as either new compound 
entry or new (additional) spectrum for an existing compound.  

On importing, the respective mass spectrum is loaded in LibraryEditor without getting 
compound and spectrum ID numbers. Corresponding data is shown in the library 
window. A compound name is entered automatically in Name consisting of the name of 
analysis the spectrum derives from and corresponding retention time. For adding the 
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imported mass spectrum to the active library, you can change the compound name to 
the desired name and perform the Add command from the Spectrum menu, which 
becomes enabled on importing a mass spectrum.  

To import a mass spectrum: 
1. Activate the library into which you want to import a mass spectrum. 
2. From the Spectrum menu, select Import. 
3. In Files of Type, select the file format of the data files to be shown in the folder 

list. 
4. In Look in and the folder list, navigate to the folder that contains the mass spec-

trum you want to import. 
5. Double-click the respective mass spectrum. Or click the respective mass spectrum 

and click Open. 
6. Add the imported mass spectrum as a new compound entry or as a new mass 

spectrum to an existing compound. 
 

5.1.2 Adding a Mass Spectrum as New Compound Entry 

A mass spectrum you have previously imported can be added to the active library as 
new compound entry. This requires assigning the spectrum to a compound name not 
yet existing in the active library.  

On adding a mass spectrum as new compound entry, a new compound is added to the 
active library getting a compound ID number for the library. The respective spectrum is 
added as the compound’s first spectrum getting a spectrum ID number. Afterwards, 
you can add additional mass spectra to such a new compound. 

To add a mass spectrum as new compound entry: 
1. Import the mass spectrum you want to add to the active library as new compound 

entry. 
2. In compound Name, enter a compound name not yet existing in the library. 

3. Click  or select Add from the Spectrum menu. 
4. If the Add New Spectrum dialog appears because you have used an already 

existing compound name, enter the desired new name in New Compound and 
then click New. 
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5.1.3 Adding a Mass Spectrum as New Spectrum for an 
Existing Compound 

A mass spectrum you have previously imported can be added to the active library as 
new (additional) spectrum for an already existing compound. This requires assigning 
the spectrum to a compound name already existing in the active library. On adding a 
mass spectrum to a compound, the respective spectrum is added to the specified 
compound as additional spectrum getting a spectrum ID number. 

To add a mass spectrum as new spectrum for an existing compound: 
1. Import the mass spectrum you want to add to the active library as additional 

spectrum for an existing compound. 
2. In compound Name, enter the name of the compound you want to add the mass 

spectrum to. 

3. Click  or select Add from the Spectrum menu,. 
4. In the compound list, select the compound the mass spectrum should be added to. 
5. Click Add to. 
 

5.1.4 Adding a Mass Spectrum Directly from DataAnalysis 

You can also add a mass spectrum directly from DataAnalysis to an existing library 
using the appropriate DataAnalysis command. This adding operation can be performed 
when LibraryEditor is running as well as when it is closed. Line as well as profile 
spectra can be added. In contrast to line spectra for which all mass lines present will be 
exported to the target library, for profile spectra only the detected peaks will be 
exported. You can add a single mass spectrum or multiple selected mass spectra 
either of the same or of different compounds at once.  

On selecting DataAnalysis' Add to Library command the tabbed Add Spectra to 
Library dialog will appear. In this, you have to specify the compound name of the mass 
spectrum/spectra to be added and the desired target library. The mass spectrum/ 
spectra can be added either to a pre-existing compound in the chosen library or as a 
new compound entry. You can define how to proceed if the target library already con-
tains a compound of the specified name. When a mass spectrum is added to a library, 
some specific data associated with the mass spectrum (e.g. instrument type, ionization 
method, MS/MS stage, precursor ions) are automatically entered as well as the 
compound details specified by the user. 
If LibraryEditor is already running and the chosen target library is currently open when 
you perform this adding operation from DataAnalysis, you have to refresh the respec-
tive library to directly get access to the new added compound or mass spectrum. 
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To add a single or multiple selected mass spectra directly from DataAnalysis: 
1. In DataAnalysis, select a single or several mass spectra to add them to a custom 

library.  
2. Right-click the data window displaying the mass spectrum and select Add to 

Library. Alternatively, you can click  or select Add to Library from the Identify 
menu. This opens the Spectra tab of the Add Spectra to Library dialog. The 
selected mass spectrum/spectra will be listed in Add compounds/spectra. 

3. Check Auto-name if the compound should be added under an auto-name consist-
ing of the analysis name and the compound's retention time. This will automatically 
enter '[analysis name]-[retention time]' in Compound name. 

 If mass spectra of different compounds are selected Auto-name will be checked 
automatically and disabled. Or leave Auto-name unchecked. 

4. If Auto-name is unchecked, enter in Compound name the explicit compound 
name. This is only allowed for a single selected compound. 

5. In Library, select the target library the spectrum/spectra is/are to be added to. Do 
one of the following:  
• Enter path and name of the desired library.  
• Click  and select the library in the Select Library dialog. 

6. If a single mass spectrum is to be added, click the Compound Details tab if you 
want to enter information on the specified compound/mass spectrum. Do the 
desired entries and/or selections. 

7. Click the Options tab and select the option that defines how to proceed if the 
specified compound name already exists in the chosen target library. 

8. Click OK. This adds the spectrum/spectra and corresponding information to the 
chosen target library using the explicit name or an auto-name. If no compound of 
the specified name exists the spectrum is added as a new compound entry.  

9. If the compound name already exists, adding is performed according to the set-
tings currently defined in the Options tab. If If compound exists, ask for action 
is selected, the Add New Spectrum dialog will appear. In this case, do one of the 
following: 
• If you wish to add the spectrum/spectra as a new compound entry, specify its 

name in New Compound and click New. 
• If you wish to add the spectrum/spectra to a pre-existing compound, select the 

desired compound from the list of existing compounds and click Add to.  
10. If LibraryEditor is already running and the chosen target library is currently open, 

refresh the respective library in LibraryEditor to get direct access to the new added 
compound or mass spectrum. 
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5.1.5 Importing a Library into another Library 

You can import a library of the Library Files format (*.mlb) into the active library in order 
to add the compounds and/or mass spectra contained in the import library to the target 
library. 

On importing a library into another library, this will result in those compounds of the 
imported library having names not yet contained in the active library being added to the 
latter as new compound entries whereas the mass spectra of the compounds having 
already existing names are being added as additional spectra to the respective existing 
compounds. To which compound ID’s of the target library new spectra were added will 
be listed at the end of the appearing import progress information. 

To import a library: 
1. Activate the library, into which you want to import another library. 
2. From the File menu, select Import Library. 
3. In Look in and the folder list, navigate to the folder that contains the *.mlb file you 

want to import. 
4. Double-click the desired *.mlb file. Or click the desired *.mlb file and click Open. 
5. After import is finished, click Close in the import information displayed. 
 

5.1.6 Exporting a Mass Spectrum 

You can export the active mass spectrum to the ASCII MS Spectrum Files format 
(*.spectrum) which is fully NIST compatible. This allows importing the exported mass 
spectrum into another library opened in LibraryEditor.  

To export a mass spectrum: 
1. Activate the mass spectrum you want to export. 
2. From the Spectrum menu, select Export. 
3. In Save in and the folder list, navigate to the folder to which the exported 

*.spectrum file should be saved. 
4. In Name, enter the name for the *.spectrum file to be exported or select a name 

from the folder list. 
5. Click Save. 
6. If you have chosen an existing file name, affirm the appearing confirmation request 

on overwriting the existing file. 
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5.2 Processing Compounds and Mass Spectra of a 
Library 

You can process the compounds and mass spectra currently contained in a library.  

For a compound, you can edit its compound data and synonym list and assign a 
structure formula to it that will be displayed in the spectrum display when the respective 
compound is selected. In addition, you can import compound information into a library 
or export it. For a mass spectrum, you can edit its Mass List, acquisition parameters 
and analysis info.  
To process compound or mass spectrum data the respective compound or mass 
spectrum must be selected, i.e. its corresponding data must be displayed in the active 
library window. 
 

5.2.1 Selecting a Compound of a Library 

You have to select the compound you want to view or process. Only one compound of 
a library can be selected at a time. The selected compound displays in the active 
library window. There are two ways to select a desired compound. You can go step-by-
step through the active library or you can directly select a compound by searching the 
library for it. 

To select a compound by browsing the library: 

1. Go step-by step through the active library using the respective button , , 

, or  until you have reached the desired compound. 

To select a compound directly: 

1. Click  or from the Compound menu, select Find Compound. 
2. Select the search criterion you want to use e.g. Compound ID or Name.  
3. For the search criterion selected, enter the respective number or name. 
4. Click OK. 
 

5.2.2 Selecting a Mass Spectrum of a Compound 

A library can contain several mass spectra for one compound, e.g. from different 
MS/MS stages or ionization methods. To view a mass spectrum available for the active 
compound you have to select this spectrum from the compound’s mass spectrum list. 
This will result in the data of the respective mass spectrum being displayed and allows 
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you to view and, if desired, process the respective mass spectrum.  

To select a mass spectrum of a compound: 
1. Select the desired compound. 
2. In the Mass spectrum list, click the mass spectrum you wish to select. 
 

5.2.3 Editing Compound Data 

The compound data of the selected compound can be edited except for its compound 
ID which is given by the system. Additionally, you can set up and edit a synonym list for 
the respective compound. Compound information can be entered manually or automa-
tically by importing an appropriate *.csv or *.tsv file. 

To edit the compound data: 
1. Select the compound whose compound data you want to edit. 
2. Make new or change existing entries. This is possible in the Name, Nominal 

mass, CAS number, NIST number, UN number, Chem. formula and Comment 
boxes provided the respective box is available and not read-only. 

3. Save changes. 
 

5.2.4 Editing the Synonym List of a Compound 

You can edit the synonym list of the selected compound by adding new synonyms or 
changing or removing already existing synonyms. 
 
To add a synonym:  
1. Select the compound whose synonym list you want to edit. 
2. Click Synonyms. 
3. In the Synonyms entry box, enter the new synonym name. 
4. Click Add. 
5. Repeat steps 3 and 4 for all synonyms you want to add. 
6. Click OK. 
7. Save changes. 

To change a synonym:  
1. Select the compound whose synonym list you want to edit. 
2. Click Synonyms. 
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3. In the Synonyms list, select the synonym you want to change. 
4. In the Synonyms entry box, change the selected synonym as desired. 
5. Click Change. 
6. Repeat steps 3 to 5 for all synonyms you want to change. 
7. Click OK. 
8. Save changes. 

To remove a synonym:  
1. Select the compound whose synonym list you want to edit. 
2. Click Synonyms. 
3. In the Synonyms list, double-click the synonym you want to remove. Or select it 

and click Remove. 
4. Repeat step 4 for all synonyms you want to remove. 
5. Click OK. 
6. Save changes. 
 

5.2.5 Importing Compound Information 

You can import compound information stored in Comma Separated Values Files 
(*.csv), Tab Separated Values Files (*.tsv) or Structure Data File (SDfiles) (*.sdf) file 
format into the active library.  

A CSV resp. TSV compound information file can contain information about one or 
several compounds concerning e.g. their chemical formula, nominal mass, CAS num-
ber, NIST number, UN number, synonym(s) or a comment. It must be created meeting 
specific requirements (see LibraryEditor Reference Manual). SDF compound informa-
tion is a collection of mol files, which will be assigned to compounds by name. 
When importing such a compound information file into the active library, the library is 
searched for all compounds having compound names identically to compound names 
contained in the imported file. If such a compound is found, its current compound data 
is supplied or replaced by the new compound information from the imported file. If no 
such compound is found importing of the compound information file will not have any 
effect on the respective library. 

To import compound information: 
1. Activate the library into which you want to import compound information. 
2. From the File menu, select Import Compound Information. 
3. In Look in and the folder list, navigate to the folder that contains the compound 

information file you want to import. 



Bruker Daltonik GmbH Building Libraries 

LibraryEditor User Manual, Version 4.0  5-9

4. Double-click the respective *.csv or *.tsv or *.sdf file. Or select it and click Open. 
5. Save changes. 
 

5.2.6 Exporting Compound Information 

You can export the compound information of the active library in either the Comma 
Separated Values Files (*.csv) or Tab Separated Values Files (*.tsv) format. This 
allows you to load the respective information e.g. in Excel. The exported file includes 
information about each compound of the library concerning its name, formula, nominal 
mass, CAS number and comment, if available. 

To export compound information: 
1. Activate the library of which you want to export compound information. 
2. From the File menu, select Export Compound Information. 
3. In Save in and the folder list, navigate to the folder to which you want to save the 

exported file. 
4. In Save as type, select the file format into which the compound information should 

be converted. 
5. In File name, enter the name for the export file, or select a name from the folder 

list. 
6. Click Save. 
7. If you have chosen an already existing file name, affirm the appearing confirmation 

request if you wish to overwrite the existing file. 
 

5.2.7 Assigning Chemical Structures to Compounds 

A chemical structure having the *.mol file format can be imported and assigned to the 
selected compound of the active library. The chemical structure will be displayed ín the 
Structure window. In addition, you can export a chemical structure currently assigned 
to a compound or delete it from the compound. 

Note: If you have already specified the location of the NIST main library, chemical 
structures from NIST user libraries can be resolved from the NIST main library. 

 

5.2.7.1 Importing a Chemical Structure for a Compound 

You can import a chemical structure having the Mol Files format (*.mol) and assign it to 
the selected compound of the active library. If a chemical structure is already assigned 
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to the respective compound, the imported structure will overwrite the current one. 
Tip: Alternatively, you can use the Import Compound Information command from 

the File menu to import an appropriate Structure Data Files (*.sdf) file in the 
active library allowing you to assign chemical structures to several compounds in 
the library at once. 

To import a chemical structure for a compound: 
1. Select the compound for which you want to import a chemical structure. 
2. From the Compound menu, select Import Structure. 
3. In Look in and the folder list, navigate to the folder that contains the respective 

*.mol file you want to import. 
4. Double-click the desired *.mol file or click the desired *.mol file and click Open. 
5. Save changes. 
 

5.2.7.2 Exporting the Chemical Structure of a Compound 

The chemical structure that is currently assigned to the selected compound of the 
active library can be exported in the Mol Files format (*.mol). 

To export a chemical structure of a compound: 
1. Select the compound whose chemical structure you want to export. 
2. From the Compound menu, select Export Structure. 
3. In Save in and the folder list, navigate to the folder to which the exported *.mol file 

should be saved. 
4. In Name, enter the name for the *.mol file to be exported or select a name from the 

folder list. 
5. Click Save. 
6. If you have chosen an existing file name, affirm the appearing confirmation request 

on overwriting the existing file. 
 

5.2.7.3 Deleting the Chemical Structure from a Compound 

You can delete the chemical structure assigned to the selected compound of the active 
library. This results in the structure being removed from the Structure window. 

To delete a chemical structure from a compound: 
1. Select the compound which chemical structure you want to delete. 
2. From the Compound menu, select Delete Structure. 
3. Save changes. 
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5.2.8 Editing Mass Spectrum Data 

The mass spectrum data available for the selected mass spectrum of the active library 
can be edited and the changes saved to the compound the respective mass spectrum 
corresponds to. Editingmass spectrum data includes the Mass List of the mass spec-
trum, its acquisition parameters and analysis info.  

Changes are not saved automatically but saving has to be induced either using the 
Change command from the Spectrum menu, or by affirming the respective appearing 
confirmation request. 
 

5.2.8.1 Editing the Mass List of a Mass Spectrum 

You can edit the Mass List of the selected mass spectrum displayed in the Mass List 
tab with respect to the masses present and their abundances. When a mass spectrum 
is imported into LibraryEditor either from the file system or directly from DataAnalysis 
the respective m/z and corresponding abundance values are automatically entered in 
the Mass List. 

You can edit a Mass List by adding new and/or changing existing masses and corre-
sponding abundances. In addition, you can remove existing masses from the Mass 
List. If you have removed the current base peak (100% mass) or changed its 
abundance below the abundance of another mass you can renormalize the Mass List 
accordingly. Changing the Mass List results in the line spectrum displayed in the Mass 
Spectrum window automatically being changed accordingly. 

To add a new mass: 
1. Select the mass spectrum of which you want to edit the Mass List. 
2. Click the Mass List tab.  
3. Click New. 
4. In Mass, enter the m/z value to be added. 
5. In Abundance, enter the corresponding abundance.  
6. Click in the Mass List. This enters the new mass and its abundance in the Mass 

List. 
7. Repeat steps 3 to 6 for all new masses you ant to add. 
8. Save changes. 

To change the m/z value and/or abundance of a mass: 
1. Select the mass spectrum of which you want to edit the Mass List. 
2. Click the Mass List tab.  
3. From the Mass List, select the mass whose m/z value and/or whose abundance 
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you want to change. 
4. In Mass, enter the desired m/z value and/or in Abundance, enter the desired 

abundance.  
5. Click in the Mass List. This changes the selected mass accordingly. 
6. Repeat steps 3 to 5 for all masses you want to change. 
7. If you have changed the abundance of the current 100% mass below the abun-

dance of another mass, click Normalize to renormalize the Mass List. This sets 
the now most abundant mass to an abundance of '999' and changes the abun-
dance values of the other masses accordingly. 

8. Save changes. 

To remove a mass: 
1. Select the mass spectrum of which you want to edit the Mass List. 
2. Click the Mass List tab.  
3. From the Mass List, select the mass you want to remove. 
4. Click Remove. 
5. Repeat steps 3 and 4 for all masses you want to remove. 
6. If you have removed the current 100% mass, click Normalize to renormalize the 

Mass List. This sets the now most abundant mass to an abundance of '999' and 
changes the abundance values of the other masses accordingly. 

7. Save changes. 
 

5.2.8.2 Editing the Acquisition Parameters of a Mass Spectrum 

You can edit the acquisition parameters of the selected mass spectrum displayed in the 
Acquisition Parameters tab. When a mass spectrum is imported into LibraryEditor 
either from the file system or directly from DataAnalysis, the information on essential 
acquisition parameters that is contained in the imported file will automatically be 
entered. You can edit the acquisition parameters of a mass spectrumby making new 
entries and/or changing existing entries. 

To edit the acquisition parameters of a mass spectrum: 
1. Select the mass spectrum whose acquisition parameters you want to edit. 
2. In the Acquisition Parameters tab, make the desired new entries or changes. 
3. Save changes. 
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5.2.8.3 Editing the Spectrum Info of a Mass Spectrum 

You can edit the spectrum info of the selected mass spectrum displayed in the Spec-
trum Info tab. When a mass spectrum is imported into LibraryEditor, either from the file 
system or directly from DataAnalysis, some information on the acquired analysis this 
spectrum derives from will automatically be entered as well as operator information.  

You can edit the spectrum info except the read-only entries in Analysis name, Instru-
ment name, Date, Operator name and Change date by adding new or changing 
existing entries. 
To edit the spectrum info of a mass spectrum: 
1. Select the mass spectrum whose acquisition parameters you want to edit. 
2. Click the Spectrum Info tab  
3. Make the desired new entries or changes, if allowed. 
4 Save changes. 
 

5.3 Deleting Mass Spectra and Compounds from a 
Library 

You can delete mass spectra and compounds from a library if you do not need them 
any longer in the respective library. Deleting a mass spectrum occurs in two steps. 
First, the selected mass spectrum will be removed from the compound it corresponds 
to but it will be put to the memory. This allows you to re-add the respective spectrum to 
the compound it derives from e.g. if you have deleted it by mistake. Or you can add this 
spectrum as a new compound entry or to another compound of the active library. 
Deletion will only become permanent when you select another compound of the active 
library without having re-added the respective mass spectrum. 
 

5.3.1 Deleting a Mass Spectrum from a Compound 

Deleting the selected mass spectrum from the corresponding compound occurs in two 
steps. On selecting the Delete command from the Spectrum menu, firstly the selected 
mass spectrum will be removed from the compound it corresponds to but it will be put 
to the memory. This allows you to re-add the respective mass spectrum either to the 
compound it derives from or as a new compound entry using the enabled Add com-
mand from the Spectrum menu. Deletion will only become permanent when you select 
another compound of the active library without having re-added the respective mass 
spectrum. 
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If the mass spectrum you want to delete is the only mass spectrum available for the 
selected compound, deletion of this mass spectrum will result in deletion of the com-
pound, too. 

To delete a mass spectrum from a compound: 
1. Select the mass spectrum you want to delete. 

2. Click  or select Delete from the Spectrum menu. 
 

5.3.2 Deleting a Compound from a Library 

Deletion of the selected compound from the active library can be performed by deleting 
all mass spectra that are currently contained for this compound in the library. On 
deleting the last of its mass spectra, the respective compound will be deleted, too.  
 
To delete a compound from a library: 
1. Select the compound you want to delete. 
2. Successively delete all mass spectra available for this compound. 
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6 BROWSING AND SEARCHING LIBRARIES 

You can browse through the active library by scrolling through compounds contained in 
this library. Or you can directly search the active library for a compound that meets a 
given specification. For example, this allows you to quickly check whether a particular 
compound is already contained in the respective library. 
 

6.1 Going to Compounds Contained in a Library 

If you want to select a compound in the active library for viewing and, if desired, 
processing it you can use different ways to go to it. Alternatively, you can search for it 
directly e.g. by compound name. 

Selecting the first compound of a library: 

1. Click  or select First from the Compound menu.  

Selecting the previous compound of a library: 
1. Click the Compound box’ down spin button. If the focus is set here, the mouse 

wheel can be used, too. Or click  or select Previous from the Compound 
menu.  

Selecting the next compound of a library: 
1. Click the Compound box’ up spin button. If the focus is set here, the mouse wheel 

can be used, too. Or click  or select Next from the Compound menu.  

Selecting the last compound of a library: 

1. Click  or select Last from the Compound menu.  
 

6.2 Searching a Library for a Certain Compound 

You can search the active library for a certain compound which you have to specify by 
either its compound ID number, (one of) its spectrum ID number(s), compound name, 
CAS number, nominal mass, chemical formula or UN number. This allows you to 
search a library for the presence of a given compound or to select quickly a compound, 
which you know to be contained in the respective library. The latter is advantageous in 
the case of large libraries because it can keep you from time-consuming clicking 
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systematic through the compounds contained until you will reach the desired one. 

With new libraries (library version 2.2 number), compound search by compound name 
also finds compounds with similar names. Thus, compounds can be found without their 
names being entered completely and perfectly right. This allows e.g. for searching a 
library for all compounds which names start with “Methyl” or “Desmethyl”. Also, using 
simple wildcards as well as ‘regular expressions’ (= special wildcards) is supported (For 
the regular expressions that can be used, please refer to the LibraryEditor Reference 
Manual.).  
Depending on whether or not one or more compounds is/are found that meet(s) the 
specified criterion one of the following will occur: 
• If only one compound is found the respective compound is shown in the library win-

dow.  
• If more than one compound is found, the Find Compound Result dialog appears 

which lists all compounds found with the corresponding Compound ID, Name, CAS 
number and Chemical formula if available. You can use the Show button to show 
the selected compound. 

• If no compound is found, a corresponding message appears informing you that the 
library 'name' does not contain a compound of the specified criterion 'entry'. On quit-
ting this message, the Find Compound dialog appears again. 

 
To search a library for a certain compound: 

1. Click  or select Find Compound from the Compound menu. 
2. Select the search criterion you want to use.  
3. If you want to search by ‘Name’ and want to use ‘regular expressions’, check Use 

‘regular expressions’ for search by ‘Name’. 
4. For the search criterion selected, enter the respective number or name. 
5. Click OK. One of the following will occur: 

• If only one compound is found, this is shown in the library window. 
• If more than one compound is found, the Find Compound Result dialog 

appears. To show a compound of the list, select it and click Show. 
• If no compound is found, a corresponding message appears. 
6. If compound search was not successful, repeat steps 2 to 5 if desired. 
 



Bruker Daltonik GmbH Appendix 

LibraryEditor User Manual, Version 4.0  A-1

A APPENDIX 

A.1 LibraryEditor 4.0 Toolbar 

LibraryEditor 4.0 provides in its toolbar the following buttons: 

Button Menu - Command Shortcut Used to… 

 
File – New Ctrl+N Create a new library. 

 
File – Open  Ctrl+O Open an existing library.  

  
File – Properties  Show properties of active library. 

 
Compound – First  Alt*Home Select first compound. 

 
Compound – 
Previous 

Alt+Left Select previous compound. 

 
Compound – Next Alt+Right Select next compound. 

 
Compound – Last Alt+End Select last compound. 

 
Compound – Find 
Compound 

Alt+F3 Specify a compound to search for. 

 
Spectrum – Add  Add selected spectrum to active library. 

 
Spectrum – Save Ctrl+S Save the changes made to selected spectrum. 

 
Spectrum – Delete  Delete selected spectrum. 

  
Edit – Cut Ctrl+X Cut selection. 

  
Edit – Copy Ctrl+C Copy selection. 

  
Edit – Paste Ctrl+V Paste Clipboard contents. 
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A.2 LibraryEditor 4.0 Menus and Commands 

LibraryEditor 4.0 provides the following menus and commands:  

File menu Commands  Used to… 

  

New 
Open 
Refresh 
Close 
Access NIST Library
 
Import Compound 

Information 
Export Compound 

Information 
Import Library 
 
Export Library 
Check Library 
Properties 
 
Recent file 
Exit 

Create a new library. 
Open an existing library.  
Refresh the active library. 
Close active library. 
Access NIST library and user 

libraries. 
Import selected compound 

information. 
Export compound information of 

active library. 
Import selected library into active 

library. 
Export active library. 
Check and rebuild selected library. 
Show number of compounds and 

spectra of active library. 
Open selected library. 
Close LibraryEditor. 

Edit menu Commands Used to…) 

 

Undo 
 
Cut 
Copy 
Paste 

Undo last performed editing 
operation. 

Cut selection. 
Copy selection. 
Paste Clipboard contents. 

Compound menu Commands Used to… 

  

Find Compound 
Import Structure 
Export Structure 
Delete Structure 
First 
Previous 
Next 
Last 

Specify a compound to search for. 
Import structure of the compound. 
Export structure of the compound. 
Delete structure of the compound. 
Select the first compound. 
Select the previous compound. 
Select the next compound. 
Select the last compound. 
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Spectrum menu Commands Used to… 

 

Import 
Export 
Add 
Save 
Delete 
 

Import a mass spectrum. 
Export selected amss spectrum. 
Add imported mass spectrum. 
Save changed mass spectrum.  
Delete selected mass spectrum. 

View menu Commands Used to… 

 

Toolbar 
Status Bar 
 

Show/Hide toolbar.  
Show/Hide status bar. 
 

Window menu Commands Used to… 

  

Cascade 
 
Tile 
 
Arrange Icons 
 
Open window list 
 

Arrange open library windows 
cascade-like. 

Arrange open library windows tile-
like. 

Arrange icons of minimized library 
windows. 

Select open library window to 
activate library. 

Help menu Commands Used to… 

  

Help Topics 
 
License 
 
 
Operator 
Lock All Applications
 
About Compass 

LibraryEditor 

Start LibraryEditor help and list 
help topics. 

License present LibraryEditor 
installation or view license 
information. 

Log in specified operator. 
Lock all Bruker Daltonics 

applications. 
Show program information.  
 

 
 
 
 
 
 
 
 



Appendix Bruker Daltonik GmbH 

A-4 LibraryEditor User Manual, Version 4.0 

A.3 LibraryEditor 4.0 Shortcuts 

LibraryEditor 4.0 provides the following shortcuts: 

Shortcut Menu – Command Used to… 

Alt+F3 Compound – Find compound Find compound. 
Alt+F4 File – Exit Close LibraryEditor. 
Alt+End Compound – Last Select the last compound. 
Alt+Home Compound – First Select the first compound. 
Alt+Left Compound – Previous Select the previous compound. 
Alt+Right Compound – Next Select the next compound. 
Ctrl+Alt+K Help – Lock All Applications Lock all Bruker Daltonics applications. 
Ctrl+C Edit – Copy Copy selection. 
Ctrl+I Spectrum – Import Import compound. 
Ctrl+N File – New Create a new library. 
Ctrl+O File – Open Open an existing library. 
Ctrl+S Spectrum – Save Save changed mass spectrum. 
Ctrl+V Edit – Paste Paste Clipboard contents. 
Ctrl+X Edit – Cut Cut selection. 
Ctrl+Z Edit – Undo Undo last performed editing operation. 
F1 Help – Help Topics Start LibraryEditor help and list help topics. 
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